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Please check www.bluebeamq.com for the most up
to
date version of 
this manual. 
 
Section 1.0 � Introduction 
 
Thank you for choosing Bluebeam Q

TM
.  Bluebeam Q (referred to in 

this manual as simply “Q”) provides a centralized and powerful 
method for converting numerous types of files in an automated 
manner.  
 

 
Figure 1 – Bluebeam Q Server 

 
AutoCAD Drawings, SolidWorks and Microsoft Office files (Excel, 
PowerPoint and Word) can be converted to a multitude of output 
formats, including PDF, TIF, and JPG.  Q also converts other 
document types such as Visio and Microsoft Project via MIME
type 
associated printing. Additionally, Q can convert numerous raster (.tif, 
.bmp, .png) or Postscript files to PDF.  
 
Utilizing the Script Engine and Application Programming Interface 
(API), PDF processing operations can be automated. In fact, the 
functionality available through the Script Engine and the API provide 
a complete solution for automating your entire PDF workflows.  
 
There are 4 primary interfaces for interaction with Q: 
 
1.  Watched Folder Interface: Any number of “watched folders” can 
be configured with specific conversion parameters. The watched 
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folders, which can be located on either the Q Server computer or on a 
network shared filesystem, can be monitored by the Q watched folder 
processes. 
 
There are two ways to configure the watched folder monitoring. You 
can point to an existing, “in
place” folder, or you can define a new 
folder for the process to watch.  In either case a conversion will trigger 
when users place a source file in the watched folder.  
 
Once a watched folder is defined, users can copy their native 
AutoCAD (.dwg) or SolidWorks (.slddrw) drawings or Office 
documents (.doc, .ppt, .xls) to any of the configured directories.  
 
A folder may be configured such that all files dragged into the folder 
will be ANSI D size. Some examples of typical watched folder 
configuration options include:  
 

• Specification of output file types (PDF, TIF, and so on). 

• Page Size definition. 

• Application of a stamp to single or multiple pages. 

• Filtering to print specific layouts within AutoCAD. 

• Adding a text stamp to all pages. 

• Inserting a cover page. 
 
When Q is configured to monitor existing folders, conversions are 
triggered at defined time intervals. For example, existing folders can 
be scanned every morning at 2:00 a.m.; any new or modified files 
since the previous scan will be converted. The timing can be freely 
configured. Typical examples would be to convert every day at a 
certain time, once a week at a certain time, or every X number of 
hours.  
 
To learn more about using the Q Manager Application for configuring 
watched folders, see Section 6.0. 
 
2.  Network Printer Interface: Q includes the Bluebeam Network 
Printer.  A printer driver can be installed onto each client computer 
within your organization.  Users can then select the Bluebeam Net 
PDF printer when printing documents from their applications and, 
after entering the name for the converted output file, Q will create the 
file and store it in the designated location.  
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Figure 2 – Network Printer 

 
Additional details about configuring and using the network printer 
feature are provided in Section 9.0. 
 
3.  API: Q supports a .NET API which can be used to develop C# or 
VB.NET (or any other .NET supported programming language) 
applications to control both the conversion/creation process as well 
as PDF processing. An extensive API help document is included with 
the installation of Q, located in {Q Install folder}\Bluebeam 
Software\Help\Bluebeam Q API.chm file. A number of source code 
examples are included in the Q distribution files to illustrate the 
functionality. Section 11.0 describes the API in further detail. 
 
               
4. The Script Engine: With Q, you can perform automated 
operations on your existing PDF files by writing and executing scripts. 
Scripts can be used to apply Headers & Footers, Stamps, PDF 
Security, and much more. Within Q there are several ways to interact 
with the Script Engine: 
 

• Configure a watched folder’s Script tab. 

• Write a custom program using the .NET API. 

• Write a stand
alone script in the Script Editor. 

• Run a script directly from the command line. 
 
The Script Editor is a separate program which can be located by 
exploring the {Q Install folder}\Bluebeam Software\Script folder. 
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A help file describing the use of the Script Editor is located in: {Q 
Install folder}\Bluebeam Software\Help\ScriptEditorHelp.chm. Section 
11.0 describes the API in further detail. 
 
System Monitoring and Management 
 
There are two interfaces for controlling and monitoring the 
performance of the Q Server: Bluebeam Q Manager and the Q Web 
Reporting Tool.  
 
The Bluebeam Q Manager (Server Manager.exe) is a program 
located on the Q Server in {Q Install folder}\Program Files\Bluebeam 
Software\Conversion Server folder. During the install process, an 
option is available to create a shortcut to this program on the desktop. 
 
The Bluebeam Q Manager is used to configure system
wide settings. 
The Q Manager is also used to define the watched folder parameters 
and to manually control the starting and stopping of the Server 
Processes. Refer to Section 6.0 for further details regarding the use 
of the Q Manager. 
 
The Q Web Reporting Tool provides a web interface for monitoring 
the status of conversions. Use the Q Web Reporting tool to view the 
status of any conversion processed by placing a file in the watched 
folders or sent through the print client. Failed jobs can be resubmitted 
through this interface. Additionally reports can be run over user

defined time periods to determine usage. Refer to Section 7.0 for 
further information regarding the Q Web Reporting Tool. 
 
Windows Selector Tool  
 
Q includes a Windows Selector Tool, which automates user 
interactions. A dialog window will often appear when an AutoCAD or 
Microsoft Office file is opened, and will need some sort of user 
intervention such as clicking an “OK” or “Cancel” button. The Window 
Handler process monitors the progress of the conversion job and 
looks for dialog windows that are waiting for user input in order to 
keep the conversion process running. The Windows Selector Tool 
configures the dialogs which the Window Handler will process. Details 
on adding handled events are described in Section 8.0, which 
provides additional information regarding the Window Selector Tool 
application.  
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Section 2.0 � System Requirements 
 
Q integrates with host applications on the Server computer. To 
convert AutoCAD (.dwg) files to PDF or other supported output 
formats, AutoCAD must be installed on the same computer that the Q 
Server is installed on. The same concept applies for SolidWorks 
(.sldpart, .sldasm, .slddrw) files and Office (.doc, .docx, .xls, .xlsx, 
.ppt, .pptx) files. 
  

Operating Systems: 
 

Windows XP SP2 or higher/Windows Vista/Windows7 
Windows Server 2003/Server 2008 
 
Most 32
bit & 64
bit OS configurations are supported. Please 
refer to Bluebeam website (www.bluebeamq.com) for up
to
date 
supported configurations.  

        
Microsoft Internet Information Service (IIS) must be installed in 
order to use the Q Web Monitoring Tool. 
 
Watched Folder or Programmatic Implementations: 
 

AutoCAD Versions: 
2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011, 2012 
64 bit versions supported 

 
Microsoft Office: 
XP, 2003, 2007, 2010 

 
SolidWorks Versions:  
2006, 2007, 2008, 2009, 2010, 2011 

 
 

Hardware 
 
A workstation
class computer is sufficient for the installation of Q. Any 
computer capable of running AutoCAD or SolidWorks is sufficient 
hardware for Q. Graphics card requirements are minimal as the 
applications run in a non
display mode.  
 
If the Q Server will primarily be used for MS Office conversions, any 
computer capable of running MS Office applications will be sufficient.  
 

http://www.bluebeamq.com/
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If the Bluebeam Q Server will be used as a Network PDF print host or 
to run Q Script Engine applications, any modern hardware platform 
will be sufficient. The Q Server has been tested with a wide range of 
computing environments from Core 2 Duo processors to the latest 
Core i7 processors. The minimal host OS memory requirements 
typically are the minimum requirement for running the Q Server. 
Generally, the more memory available, the better overall system 
performance will be. 
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Section 3.0 � Installation 
 
Prerequisites:  
1. If you are installing on a computer with a Windows Server OS, 
ensure that it is not configured as a domain controller. Because Q 
requires a local user account, it cannot be installed on a computer 
that is configured as a domain controller. 
 
2. Applications that are used for conversion must be installed on the 
server computer: AutoCAD, SolidWorks, Office, etc. We recommend 
that prior to starting the Q installation process, these applications be 
installed.  
 
3. As part of the installation, the Windows Installer will be upgraded to 
version 3.1 and the Microsoft .NET 3.5 SP1 framework will be 
installed.  
 
4. There are two primary modes for running Q, as a Windows Service 
or in Standard (Interactive) mode. If the Q Server will be used for 
performing source to PDF conversions (e.g. AutoCAD or Office to 
PDF) Q will need to run in Standard mode. This is because the host 
programs (AutoCAD, SolidWorks, Office) must start the applications 
in a Windows context as part of the conversion process. If the Q 
Server will be acting only as a print host or to run Q Script Engine 
applications, it can be run either in Standard mode or as a Service. 
 
If you choose to run as a service, a user account must be created on 
the server computer, with the following settings: 
 

• The account should have administrative privileges. 

• The password should be set to never expire. 

• Add the user to Administrative Tools\Local Security 
Policy\Local Policies\User Rights Assignment\ 

o ‘Log on as a service’; and 
o ‘Increase quotas’ or ‘Adjust memory quotas for a 

process’ 
              Note: If these privileges are not set, the installation   
              process will set these permissions for you.  
 
NOTE: You should be the Administrator or have administrative 
privileges on the server computer when performing the 
installation.   
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1. Start the installation program. 
 

• It is recommended that you check the Bluebeam website 
(www.bluebeamq.com) for the latest download of Q. If 
you downloaded the software from the Bluebeam web

site, double
click: BluebeamQ400.exe (or 
BluebeamQ400x64.exe for 64
bit installs). Note the 
latest shipping version number may be different; however 
the setup program will be similarly named. 

 
or 

 

• If you have the CD, load it in your CD
ROM drive. The 
CD is set to autorun; if the installation does not start 
automatically, run setup.exe on the CD. 

 
NOTE: Depending on which version of the Windows Installer is 
present on the system, the installation program may require that 
Windows be restarted at this point. 
 
2. Welcome 
 
Click Next on the first screen to be guided through the remainder 
of the installation process. 

 
3. License Agreement 
 
Please read the license agreement. Click Yes if you agree to the 
license agreement and want to continue with the installation 
process. Otherwise the installation will exit. 
 
4. Setup Type 
 
Choose the Standard Installation to run the server in an 
interactive mode. Select Service Installation to run as a 
Windows Service. Refer to the section Section 6.0 Using the Q 
Manager Application for further details. 
 
Reminder: Service mode should only be used for hosting the 
network print clients or using the Script Engine only. When 
using the plugins to convert AutoCAD, SolidWorks, or MS 
Office files via a watched folder, the Q must be configured to 
run in Standard mode.    
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Complete the setup dialog by choosing the destination directory 
to store the Q installation and program files.  
 
5. Install Options 
 
As part of the Q Installation, Revu (Bluebeam’s PDF viewing and 
editing application) will be installed on the Server. Check Place a 
shortcut for Bluebeam PDF Revu on the desktop to add the 
shortcut. The second checkbox should be checked to make Revu 
the default viewer. Checking the third checkbox will place a 
separate shortcut for the Q Manager on the Desktop. If you 
choose not to place these shortcuts on the desktop, the 
applications can be accessed later through the Start Menu. The 
final checkbox “Install Internet Explorer plugin for viewing PDFs” 
will add the PDF viewing plugin to IE on the server computer. 
This setting is off by default.  

 
6. Service Account 
 
If the Service Mode is selected, enter the username and 
password of the service account which will be used to run the 
server (this is the user account defined as part of the 
prerequisites). If you wish to use an existing account, enter the 
existing account information. Select create new account if you 
wish to create a new username and password based on the 
information entered in this dialog.  
 
7. Registration 
 
At purchase time, you will be provided with a Serial Number and 
Product Key. Please refer to the email that was sent to you for 
licensing information.  

 
Enter your Serial Number and Product Key and click Register. If 
you are evaluating the software, click the Use as Trial button to 
proceed. 
 
Note: You can access the registration screen for the Q license 
after installation via the Tools menu in the Bluebeam 
Administrator (Start > All Programs > Bluebeam Software > 
Bluebeam Administrator). 
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Online Authorization 
After you click Register, online authorization will be attempted 
automatically.  This authorization process will activate the 
software on your computer. If the authorization process 
cannot connect to the Internet, you will be prompted to 
authorize manually.     
 
Manual Authorization 
Click Authorize Manually.  The Manual Authorization screen 
will appear.  It will prompt you for an Authorization Code.  You 
can obtain an Authorization Code by selecting the Web 
button or going to http://www.bluebeam.com/authorize.asp 
 
Note that the installation will automatically attempt an online 
authorization. If the online authorization fails, the manual 
authorization dialog will be displayed. The manual option will 
only appear if the online authorization fails. 
 
If you cannot access the web page, contact Bluebeam by 
clicking Email.  A request is sent to 
registration@bluebeam.com, and an Authorization Code will 
be returned to you via email.   
 
To obtain an Authorization Code, please reference your 
Serial Number and Product Key. 

 
Once you receive an Authorization Code, please enter it and 
click Authorize.  The system will authorize your computer.   
 

8. Finish 
 
Use this dialog to determine what actions to perform once the 
installation is complete. It is recommended that you leave 
Launch Getting Started Wizard checked. The wizard will guide 
you through the watched folder and other configuration choices. 
The wizard is explained in the following section.  
Launch Q will start the server processes running. 
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Section 4.0 � Using the Setup Wizard 
 
The Getting Started Wizard starts after the initial installation of the Q 
Server. If you wish to run this program at a later time, it can be 
accessed under Start > Programs > Bluebeam Software > Bluebeam 
Setup Wizard. The wizard assists with configuring several of the 
interfaces for normal Q operation.  
 
The settings in this dialog are used to configure primary interfaces to 
Q (the Watched Folders, the Network Printer, the Q Web Reporting 
Tool), and to display further information about the API/Script Engine.  

 
 

 
 
 
 

Setup Watched Folders 
 

There is a 3 step process for configuring the watched folders. Use the 
Q Manager after this initial setup to configure specific parameters for 
the watched folders. 

 
Step 1 of the Setup Wizard determines how the watched folders are 
to be used.  
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Use existing folder for in�place conversion 
 Select this to point Q 
to a set of folders which you currently have defined for your projects. 
Press the Browse button to select the base directory to monitor. You 
can point to an existing folder to actively monitor source files. As 
source files are modified or added into the folders, Q will convert the 
files to the specified output type (.pdf, .tif, .jpg, and so on). The source 
files will remain in the same location after the conversion completes.  
 
Create new folder for drag/drop conversion 
 Defines a new 
location which will be monitored for conversions. Any time a source 
file is dragged into the folder, an output file will be created and the 
source file will be moved to an archive location. By moving the source 
file used for conversion out of the source folder, the source folder 
should generally remain empty, except for any file which has not yet 
been converted.  
 
Check the Scan Source Subfolders box to look in all subfolders for 
files. If you want to monitor just the one folder indicated in the 
directory box, leave this unchecked.  
 
Include Sample Source Folders 
 Creates a default set of sample 
pre
configured folders for drag and drop conversion. The watched 
folders will be located in C:\Bluebeam Q\Watched Folders. These 
sample folders are included for illustrative purposes and may be 
deleted if you do not need them. They do provide a good starting 
point for learning about how the watched folders can be configured. 
 
Step 2 of the Watched Folder setup wizard specifies the output 
location for the converted files.  
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There are 4 options: 
  
Same Folder as Source 
 Places the converted file in the same 
location which the source file resides.  
 
Subfolder under Source – Selecting this option displays the folder 
path window. The subfolder name entered here is where Q saves 
converted files. Consider the following example: 
 
Q is configured to monitor P:\projects and the Scan Source Subfolder 
option is selected. These folders will be monitored: 
 
P:\projects\project101 
           \project200 
 

If pdf is entered in the folder definition box (the text entry box to the 
left of the Browse button), converted PDFs will be placed in the newly 
created pdf folder under each actively monitored folder:  
 
 
P:\projects\project101 
                      \pdf {output files placed here} 
            \project200 
                      \pdf {output files placed here} 
 
 

One Common Output Folder – Places all converted files from all 
watched folders into one common output folder. If the “o:\output” 
folder is defined with this option, all output files from all monitored 
subfolders will be placed in this folder.  
 
 

http://www.bluebeamq.com/
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Mirrored Source Folder Tree – Creates a mirror image output tree 
structure of the watch folders. If the watch folders are monitored 
 
P:\projects\project101 
           \project200 

 
and “O:\output” is defined in the folder selection with this option 
checked, the output files will be placed in the following locations 
 
O:\output\projects\project101 {converted files here} 
                  \project200 {and here} 

 

 
Step 3 completes the watch folder configuration process  

 

 
 
Launch Q Manager – Starts the Q Manager for additional watched 
folder configuration options.  
 
Explore the Watched Folder – Opens the root watched folder in a 
separate explorer window.  
 
Launch Bluebeam Q – Starts the Q server processes. The main 
process for running the Q server is BbServer.exe. The Q Manager 
(see Section 6.0) application displays the active running Q processes 
in the Processes > Mode tab. The typical processes running include: 
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Once your Watched Folder is selected you can Close the setup 
wizard, or go Back to display information regarding the other 
interfaces for Q. 
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Network Printer Information Setup Wizard  
 
Choosing to set up the network printer displays the network printer 
interface settings.  
 
  

  
 
 

Open the Network Printer deployment README file – gives a 
detailed procedure for setting up the network printer clients. The 
README walks through the steps for performing an installation of the 
network printer on your users’ computers within your organization. A 
print client installation must be run on each user’s computer who will 
send print jobs to Q. The README additionally describes techniques 
for performing an automated client installation.  
 
Explore Network Printer Folder – Opens the folder containing the 
installation files needed to run on users’ computers. In addition to the 
setup files, support files to aid in the automated installation are 
included in this directory. 
 
Launch Bluebeam Q – Starts the Q processes.  
 
Once the options are applied you can Close the setup wizard or go 
Back to display information regarding the other interfaces for Q. 
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API Information Wizard screen 
 

 
 
Open API Help File – Displays the Windows help file describing the 
API for interacting with Q. 
 
Explore Code Samples Folder – Opens to the folder containing the 
VB.NET and C# samples for interacting with the Q API. There are 
also examples describing the Script Engine interface.  
 
Launch Bluebeam Q – Starts the Bluebeam Q processes.  
 
Once the options are applied you can Close the setup wizard, or go 
Back to display information regarding the other interfaces for Q. 
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Configuring the Q Web Reporting Tool 
 
The last option in the configuration tool is to install the Bluebeam Q 
Web Reporting Tool. The Bluebeam Q Web Reporting Tool provides 
a web interface for monitoring the status of conversions. Use the 
Bluebeam Q Web Reporting tool to view the status of any conversion 
processed by placing a file in the watched folders or sent through the 
print client. Failed jobs can be resubmitted through this interface. 
Additionally reports can be run over user
defined time periods to 
determine usage.  
 
This installation requires that Microsoft Internet Information Servers 
(IIS) be installed on the same system with Q. If you do not wish to 
install the Web Reporting Tool, press the Cancel button. If IIS is 
currently not installed or enabled, this process will install IIS. During 
the installation of IIS you may be prompted for your Operating System 
installation CD. If you do not wish to install IIS, uncheck the Install 
Internet Information Services checkbox.  
 

 
 
The Q Web Reporting Tool provides the capability to remotely view 
log files. If you wish to enable this feature, make sure the Enable 
Remote Log Viewing is checked. Likewise, the Reporting Tool can 
be configured to start and stop the Q processes. If you do not want to 
enable this for security reasons, uncheck the Enable Remote 
Process Control checkbox. 
 
In Step 2 you will configure the accounts for access to the Q Web 
Reporting Tool. There are other settings to encrypt the passwords 
(optional). You can also use this dialog to add users to the system by 
pressing the Add button. 
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The last step controls what to do after the Q Web Reporting Tool 
completes installation. Checking the Open Web.config file box 
displays this file for further editing. To view a document describing the 
steps for manually configuring the Q Web Reporting Tool (not 
required if the installation completed successfully), check View 
manual web tools setup tutorial. And finally to launch Q after the 
installation process is complete, check Launch Bluebeam Q.  
 
 

 

http://www.bluebeamq.com/
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Section 5.0 � Q Operation 
 
Q Server Modes 
 
The Q Server can run in either an interactive/application (Standard) 
mode or as a Windows service. If you intend to use watched folders 
or the Conversion API specifically for converting files, the Q Server 
should be run in Standard Mode. If the Q Server is to be run using 
only the network printer, the server should be run in Service mode. If 
the Script Engine will be used for processing PDFs, it is 
recommended that the Service mode be used.  
 
When the server is configured to run in Service mode, each time the 
computer on which the Q Server is installed is restarted, the Server 
processes will startup in the background. You can monitor the 
process by starting the Task Manager (Ctrl
Alt
Del, Task Manager) 
and looking for the BBServer process.  
 
Start > Programs > Bluebeam Software contains the following: 
 

 

 
 

To display a console window while the Server is running, click 
Bluebeam Q Start – Display. To start the Server without displaying 
the console window, click Bluebeam Q Start – Quiet. In order to shut 
down the Q Server, click Bluebeam Q Stop. If the Q Server is set to 
start as a service, it will automatically restart on the next server boot. 
If Q is set to run in Standard mode, it will need to be restarted via the 
shortcuts described above.  
 
Archiving 
 
As files are converted, the original source files are moved to an 
archive directory. By default, the archive directory is located at  
{My Documents}\Bluebeam\backup. Each job is given a job ID. A 
typical directory that has several converted archive directories would 
appear like the following illustration. 
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It is recommended that periodically this directory be cleared out in 
order to keep the disk usage down. The Q Manager provides a 
mechanism for automatically clearing the archive folder on a regular 
basis. 
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Section 6.0 � The Q Manager Application 
 
The Q Manager is the primary interface for configuring Q. Typical 
settings that can be configured are: 
 

• Running the server in Standard or Service Mode. 

• Starting and stopping the Q server processes.  

• Creating and configuring watched folders. 

• Removing temporary and archive folders. 
 
The following sections describe the configuration options. 
 
General Settings 
 

 
 
Default Folder Locations  
 
Watched Folder � Specifies the top level location for the watched 
folders. This may point to a pre
existing location that has a repository 
of source files for conversions, or it may be a new folder. 
 
It is very important that if the watched folder is pointing to a pre�
existing location, the Move input files after conversion (in the 
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Watched Folders > Advanced Settings dialog) not be checked, or 
original source files will be relocated to the archive file.  
 
Output Folder – The default output location for files that the Q Server 
processes.  
 
Archive Folder – Location where source files are archived after a 
conversion takes place. Each time a conversion is performed the 
source file will be moved to this location.  
 
Database Folder – Location of the Q conversion history database 
file. Each time a conversion is attempted, the information is logged to 
this database. The Q Web Reporting Tool uses this data for reporting 
job status and the Q Server uses this to determine which files to 
attempt to re
convert. It is recommended that this database be 
backed up on a regular basis.  
 
Automated File Cleanup 
 
These settings are used to automatically delete various files that may 
remain during the course of normal conversion operations. The 
Frequency setting determines how often to check for old files. The 
Min File age deletes files older than the specified time. As an 
example, if the Frequency setting is 24 hours and the Min. File age 
is set for 12 hours, the process will check every 24 hours and remove 
files that that are older than 12 hours.  The 4 areas that are scanned 
are: 
 
Temp folder – During the conversion process certain intermediate 
files are created. These files are generally cleaned up automatically, 
however sometimes certain files will remain. Often these files have a 
.pxb or .mxb file extension in any one of several temporary 
directories. These files will be removed if this cleaner is enabled.  
 
Watched folders – Files may sometimes be placed in a watched 
folder which the Q Server does not know how to convert. The files will 
remain in the watched folder. Over time the watched folders will 
accumulate these unconvertible files. Set this cleaner to remove files 
older than a certain age. Note: the files, if they are removed, will 
be deleted permanently from the filesystem. 
 
Output Folder – Enable this cleaner to remove files placed in any of 
the defined output folders. Any file that remains in any output folders 
outside of the defined time parameters will be deleted.  

http://www.bluebeam.com/authorize.asp
mailto:registration@bluebeam.com
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Archive Folder – After a conversion successfully completes, the 
source file is moved to the defined archive directory. The archive 
directory is primarily meant to provide a means of recovering a source 
file if a user accidentally moves a source file into the watched folder. If 
the archive folder is not cleaned in a regular manner, it may get very 
large due to all of the source files potentially being copied to this 
location. 
 
Miscellaneous Settings 
 
This area controls a number of other settings related to the operation 
of the Q Server.  
 
Timeout – Sets the system timeout for conversions. If a Conversion 
has not completed within this specified time, the Q Server will move 
on to the next Conversion job. 
 
Overwrite output files – If this option is checked, output filenames 
will be overwritten. If this is unchecked, each filename will have a 
number appended to the filename. For example, if project6
document.pdf exists and a new version is created with this checkbox 
unchecked, the new name will be project6document001.pdf. If a 
conversion occurs again, another file will be named project6
document002.pdf.  
 
Log Conversions in DB – Each time a file conversion is performed, 
information is written to a database regarding the files converted and 
the status of the conversion. If you wish not to store the conversion 
information in the database, uncheck this option. If you do not store 
conversion information, the Q Web Reporting Tool will not be able to 
display report and statistical information for the conversions. 
 
Allow Web Resubmit – Checking this option will allow failed 
conversion jobs to be re
submitted through the Q Web Reporting tool.  
 
Network Printer Port – Sets the default port that the Q Server listens 
to for print job requests. Client workstations need to be configured to 
connect to a specific port on the Q Server when using the Network 
Printer Interface. Define the port for the Q Server to use by entering a 
port number in this field. Refer to Section 9.0 for further details about 
the Print client. 
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Global conversion filters 
 
Ignore – Q will not attempt to convert any files with an extension type 
present in this list. An example of why this is useful would be DWL 
files. When AutoCAD opens a drawing file, it creates a lock file with 
extension.dwl and the same name as the associated AutoCAD 
drawing. When the .dwl extension is present in the Ignore list, the Q 
Server will not attempt to convert this file if it exists in the watched 
folder. 
 
Include Only – Q will only convert filetypes with the extensions 
specified in this list. Use this option if the Q Server needs to be 
configured to only convert a few specific types of files. 
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Watched Folder Configuration 

 
The Q Manager provides extensive tools for configuring watched 
folders. There are 5 tabs in the Watched folder configuration. On the 
left
hand side of the dialog is a folder tree indicating the currently 
defined watched folders.  
 

 
 
When a folder is selected, the settings currently defined for the 
selected watched folder are displayed in the tabs (Input/Output, Page 
Setup, Stamps, Filters, Advanced, Script) on the right
hand side of 
this dialog.   
 
To create a new folder, right
click the 
parent folder to display a context menu, 
then click New Folder. Copy Folder will 
make a new folder with the same 
properties as the source folder. Rename 
Folder changes the name of the folder. 
Explore Folder opens the folder in 
Windows Explorer.  
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This section explains the configuration settings available for the 
watched folders. The settings are described by tab.  
 
Input/Output 
 
Trigger � The Server can run in Standard, Event, Interval or 
Event/Interval Mode. Standard mode relies on Windows processes 
to notify the Q Server that a file is ready to be converted. In Interval 
mode the server scans the watched folders at specified times to 
determine if there are any new or modified source files to convert. If 
there are new or newly modified files since the last time the scan was 
performed, Q converts the files to the specified output format. The 
scan time is set by modifying the Interval field below Trigger. Event 
mode uses Windows processes to indicate when a file is updated or 
first placed in a watched folder. Event/Interval mode triggers a 
conversion any time a new file is placed or an existing file in the 
watched folders is modified. The “Event” in Event/Interval refers to 
any Windows file system update that occurs within the watched 
folders. 
 
Using Event/Interval ensures the most rapid conversion from source 
to output file since the watched folder structure will be continuously 
scanned for new or modified folders.  
 
Set the Interval period by pressing the Add button. The interval 
setting works by scanning “at some point” per scan interval. For 
example, if 2 AM under Hour is the only value entered in the interval 
fields, Q will scan once per day at some point in the 2:00 AM hour. If 
you need to make this time a closer constraint, set the minute value, 
for example enter “10”. This will instruct Q to scan the watched folders 
each day at some point between 2:10 and 2:11. It is recommended to 
set the hour and minute interval for daily scans.   
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Set the Include subfolders checkbox to scan any subfolders for new 
or modified files to convert. Enter any output folders in the Exclude 
Paths to ignore the output file locations. Entering these paths will 
prevent “conversion loops” from occurring. 
  
Next specify the Output Location for the currently selected Watched 
Folder. Use Source Folder places the output file in the same folder 
as the source file location. Note that if you are going to use this 
option, it is recommended that you filter the output file type by adding 
the output file type to the Ignore list discussed in the previous 
section. For example, if the Use Source location is checked and the 
output file type is defined as PDF, make sure that PDF is in the 
Watched Folders 
 Filters dialog so that the PDF file will not be re

converted. Note: If “.pdf” is added to the ignore list, and if scripting is 
set, the PDF will not be processed. You should specify a separate 
folder for processing PDFs if you want to apply scripting operations to 
PDFs.  
 
Use default folder to select the default folder as identified on the 
General settings, Output Folder setting.  
 
To specify a different output folder, click the Set folder button and 
enter the path in the text box to the right of the button, or choose the 

file selection button  next to the file path text box.  
 
To select an output file type other than PDF (including PDF/A for 
archiving), click the Save As Type list under Output Options. To 
overwrite existing files with the same name in the output folder, click 
On in the Overwrite output file list. If the mode is set to Off, a 
numeric value will be appended to the end of any duplicate file 
names. Subsequent conversions will be saved with an incremented 
number appended to the end of the filename. If [Use default] is 
selected, the default Overwrite setting from the General tab will be 
used. 
 
Check the Mirror source folder tree box to build up subfolders 
similar to the source folder structure. If this is not selected, all 
resulting converted files will be placed in one folder specified in the 
Output Location.  
 
Check the Line Merge Enabled box to created line merged PDFs 
from the AutoCAD plugin. 
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Watched Folders – Page Setup 
 
This tab is used to control the output (or converted) file parameters. 
 

 
 
 
The left hand panel (Select watched folder) displays the currently 
configured watched folders.  
 
Once a particular watched folder has been selected, change the 
parameters by editing the values on the right
hand side of the 
watched folders dialog. These parameters are described below.  
 
DPI – sets the dots per inch (DPI) setting to use for graphics included 
in files. If PDF is defined as the output filetype this is the down

sample resolution to use when converting files that have embedded 
graphics. If a raster output file is chosen (JPG, TIF) this is the overall 
DPI setting to use for the output file. 
 
Color depth – Defines the number of colors to have available in the 
output file. For black and white choose 1 bit. 
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Blend Mode – Enables or disables transparency in the output file. 
When converting AutoCAD files, this setting enables or disables what 
is often referred to as “line merge” on drawing files.  
 
Page size 
 Select the page size to use for the output file. If the Page 
size does not appear in the drop down, use the Bluebeam 
Administrator to add a custom Page Size. The Administrator can be 
started under Start > Programs > Bluebeam Software.  
 
Orientation 
 Define the default orientation (Portrait/Landscape). 
 
Scale – Scale factor of the source document. 
 
Transfer Options 
 When Converting AutoCAD, SolidWorks, 
Microsoft Word, PowerPoint, or Excel files, Bookmarks, (file) 
Properties and Hyperlinks can be transferred into PDF files. Check 
these boxes if you wish to transfer this information into the PDF.  
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Watched Directory – Stamps  
 
Place a text stamp using the Stamps menu. Use the Stamp Editor 
accessible under Start > Programs > Bluebeam Software to define 
custom stamps. A detailed help file describing the use of the Stamp 
Editor is located at: {Q Install folder}\Bluebeam 
Software\Help\StampEditor.chm  
 
 

 

 
 
 
Watched Directory – Filters 
 
Conversion Filters 
 Use the Ignore/Include Only settings in this 
tab to specify which file type to attempt to convert. Q will not attempt 
to convert file types entered in the Ignore section. Alternatively 
setting a file type in the Include Only field causes Q only to attempt 
conversion of these specified file types.  
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When converting AutoCAD files, use the Include layouts setting to 
specify Model and All Layouts, or just All Layouts. There are several 
other settings to specify which layouts to use when converting the 
source AutoCAD drawings. Setting the Date filter instructs Q to 
ignore all source files before the given date. That is, if the date is set 
for July 2, 2002, all source files older than this date will not be marked 
for conversion. 
  
By default Q will not convert a file if it has already been converted. If 
the file has been modified since last conversion, it will be re

converted. If there has been no modification to the file and you wish 
to force a conversion, leave the Only convert new and modified 
files button unchecked. Otherwise conversions will only occur on 
newly added files to the watched folders, or if a file has been updated. 
 
Watched Directory – Advanced  
 
Q uses Bluebeam plugin technology for converting AutoCAD, 
SolidWorks, Microsoft Word, PowerPoint and Excel files to PDF and 
the other output file formats. Use this tab to add parameters to the 
watched folders for setting plugin
specific settings to control the 

 

 36

conversion. Additional settings can be configured by pressing the 
Add button. Certain parameters depend upon other parameters to 
also be defined. If a parameter is selected that depends upon another 
parameter, the Q Manager will automatically add this additional 
parameter to the Application settings.  
 
Move input files after conversion will move the source files to the 
Archive folder specified in the General Settings tab. If this watched 
folder is pointing to a general projects folder this option should be 
turned off since source files in folders may inadvertently be moved.  
 
 

 
 
 
Watched Directory – Script 
Use the script tab to enter commands for processing PDFs placed in 
a watched folder. This panel contains an intelligent script editor which 
assists in the entry of syntactically correct scripts. Scripts will not run 
unless the Enable Scripts checkbox is checked in the tab. 
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Use the CTRL+Space keyboard shortcut to get a list of available 
commands for the Script Engine. As you are entering commands, 
pressing Tab will enter default values for the script to assist in rapidly 
developing the scripts. Refer to the Bluebeam Q Watched Folder 
Script Reference as part of the Q Server software distribution for a 
complete description of available commands. The Save PDF after 
running script should be checked in order to save the PDF after it 
has been processed by the script. 
 
When processing files in the Watched Folders, Bluebeam Q 
automatically handles the opening, saving, and closing of the PDF 
files taking into account the source and destination folders already 
associated with the Watched Folders. Therefore, Watched Folder 
scripts are very simple, and in many instances are only one line. 
There can be more than one command in a script file, for example 
you could write one script to insert a cover page, add headers and 
footers, flatten and apply security.  
 
One additional note, the Script Editor is actually an embedded version 
of the full Script Editor application available under Start > Program > 
Bluebeam Software. This same editor can be used to edit Scripts that 
can be sent to the command line for processing by the Script Engine. 
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The Bluebeam Script Reference included with the Q Server 
distribution provides more information regarding running Scripts in 
this manner. This document is located in the directory under 
{Q Install folder}\Bluebeam Software\Help.  
 
Server Manager – Processes/Modes 
 
This tab controls the starting and stopping of Q and provides a 
convenient display of process status as the Q runs. The display is 
similar to the Processes window in the Windows Task Manager.   
 

 
 
There are 2 modes in which to run Q: 
 
Standard Mode – Runs in a “live” or interactive user account. In this 
state Q runs as a logged
in user. This is the most reliable setting for 
using the watched folder interface when converting AutoCAD, 
SolidWorks or MS Office documents. Because of Windows security 
and application requirements, this is the only mode that the Server 
should be run in if the watched folder interface is being utilized.   
 
Service Mode – Starts Q as a set of Windows services.  This will run 
AutoCAD, SolidWorks and Office applications in a service mode when 
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converting these native document types. This is not a recommended 
configuration due to limitations of Windows security. This mode can 
be used if you are primarily using the Bluebeam Network printer or 
the Script Processing Engine.   
 
You can switch between the modes by selecting corresponding radio 
button and pressing the Apply button. Press the Restart Server 
button to stop and automatically restart the server in the new mode.  
 
Q Manager – Converters  
 
Converters Enabled allows you to take advantage of multiple
core 
modern computer hardware. The number should only be increased 
above 1 if Q is running on a multiple
core or multiprocessor 
workstation. If multiple converters are started, use the Windows Task 
manager to set the affinity of each worker to different processors on 
the server to maximize throughput of conversions.  
 
 

 
 
 
Check the Close Existing Processes to ensure that conversion jobs 
will not get attached to currently running sessions of applications.  
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It is possible to restart the host applications after a certain number of 
conversions have occurred by setting the values in the Conversions 
Before Reload for each application. If this value is set to ‘10’ for the 
AutoCAD converter, the Q server process will launch AutoCAD and 
the AutoCAD process will remain open for 10 conversions. After the 
10

th
 conversion a restart of AutoCAD will occur. It is recommended to 

set values for restarting the applications because oftentimes, when 
applications remain open too long, they will tend to consume more 
and more memory and resources. These resources are freed when 
the application restarts.  
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Section 7.0 � The Q Web Reporting Tool  
 
The Q Web Reporting Tool is an application to provide status 
information that is accessible via a web browser. To access the Web 
Reporting Tool, simply enter localhost into an open web browser on 
the workstation running Q.  The default login is user: admin; 
password: admin. Once you log in, the overview will be displayed. 
 
The overview gives summary information about the number of jobs 
configured over the past several days; a list of the last jobs converted; 
jobs that are currently in queue and current Q system processes.  
 
 

 
 
 
If a job failed, a red icon will be next to the job in the Last 10 Jobs 
box. Click the line to see further detail about the job. Jobs may be re

submitted if conversions fail. To see the active conversions taking 
place, click on a line in the Conversion Queues box. For example, to 
see the current AutoCAD conversions taking place, click the AutoCAD 
job conversion queue. 
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The colored circle next to the line indicates progress: red indicates 
failed, yellow means in
process and green indicates the job has 
finished. Clicking the Details link will display more information. 
 

 
 
There are additional pages accessible through the navigation bar at 
the top of the overview. Use the Graphing page to obtain reports 
about completed and failed conversion jobs over a user definable 
date range.  
 
Processes shows processes currently running related to the server. 
Q can be stopped and restarted and individual processes can be 
stopped on this screen.  
 
The Jobs page shows recent conversion jobs. Reports can be run by 
specifying the date criteria at the top of the page. Reports can also be 
run on failed or successful jobs. 
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Any jobs sent through the network print client are listed on the Client 
Print job list page. If the client IP address name can be resolved by 
the server, the name of the host will be displayed in the source 
column, otherwise the client IP address is displayed. 
 

 
 
Statistics provides a lifetime summary of the total conversions 
performed by Q.  
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Section 8.0 � Using the Windows Selector Tool  
 
This section describes the process for configuring the Window 
Selector Tool to catch additional Windows dialogs which may pop up 
when a source file is opened. The Window Selector Tool will 
automate button pressing, simulating user input so that the 
conversion can complete conversions. Without utilizing the Window 
Selector Tool, conversion jobs will get “hung” as the Q Server will be 
waiting for user input. There are 3 main steps for adding a new 
window handler event to Q: 
 

1. Trigger the dialog box which you want to automate. 
2. Teach the Window Selector Tool to handle the dialog. 
3. Save the changes.  

 
We will now walk through the steps for a specific example. 
 
We want to add a window handler event to automatically press the 
“Disable Macros” button each time the following window appears 
when an AutoCAD drawing is opened. 
 

 
 
 

• Start AutoCAD on the Q workstation and open a drawing for 
which the preceding popup appears. 

• Load the Window Selector Tool program: 
o On the Start menu, click All Programs. 
o Click Bluebeam Software. 
o Click Bluebeam Conversion Server. 
o Click Window Selector Tool. 

• Teach the server to handle the new window: 
o Click the red Teach button.  (See following 

illustration.) 
o The Window Selector Tool will vanish momentarily so 

you can focus on the target AutoCAD window. Click 
the Disable Macros button to record the action.  
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• Now you will save the changes. 
o In the Macro Action Selector, type in a name for the 

new macro, and click OK. 
 

 
 

o The Window Selector dialog will reappear and display 
the new macro. 
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o On the File menu, click Save. This will write the new 
window handler macro to the server. 

• Finally, let’s test the updated Window Handler. 
o Open a drawing that previously triggered the “Disable 

Macros” dialog. You should see the dialog pop up 
briefly, then disappear. 

      
If you no longer wish to automate the handling of a window, select the 
Macro in the Application tree, right
click on the macro you wish to 
remove, and select Delete. 
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Section 9.0 � Network Printer 
 
Users can access Q by installing the network printer on a client 
machine.  After installing Q, the network printer installation files will be 
located in {Q Install Folder}\Conversion Server\PrintClient.  Refer to 
the PrintClientREADME.rtf file for examples of how to do a silent 
install (for network deployment). 
 
Installing the Network Printer Client 
 
The Bluebeam print client installs a Windows system printer device 
(Bluebeam Network PDF) on each user’s computer who will be 
printing to the Bluebeam Q server. Note the print client is not needed 
if you wish your users to interface with Bluebeam Q via the Watched 
Folder, API, or Script Engine interfaces.  
 
The Print Client interface follows a Client
Server model. The Q server 
is installed centrally on a workstation and any number of print clients 
can access the Q server through the Network PDF printer. This 
interface utilizes a network connection to communicate between the 
client computer and the Q workstation. 
 

 
 
 
The Server is running a process “listening” for print jobs from any 
number of clients. By default Q listens on port number 4041. If the 
workstation running Q is using a firewall, you need to open this port.  
 
In order to add the Network Printer client to the client workstations, a 
setup program needs to be run. When Bluebeam Q is installed, this 
setup program is placed in the following directory: 
 
C:\Program Files\Bluebeam Software\Conversion 
Software\PrintClient 

 
You should either copy the contents of this file to the client 
workstations, or make this folder a network share that can be 
accessed from the client computers. Then follow this procedure: 
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• Run the NetPrinter_32bit.exe program (or NetPrinter_x64.exe 
for 64
bit operating systems) to begin the install on the client.  
Once the install is complete, a new printer will be added to 
the user’s workstation called Bluebeam Net PDF. 

 

• Configure the printer by starting the Administrator. 
 

o On the Start menu, click All Programs. 
o Click Bluebeam Software. 
o Click Print Client Administrator. 
o Enter the name of the server (or IP Address) in the 

dialog.   
 
If you have multiple servers running Q, you can add additional server 
name / port combinations via the Manage Servers dialog.  The client 
will try to connect to each server in the list from the top down. If none 
of the servers can be contacted, the print job will fail.  There is also a 
setting to randomize the order for each print job (for load balancing). 
 

 
 

• Press Test to ensure that the client can connect to the 
Bluebeam Q server. If there is a timeout, verify that: 

o If a firewall is running on the Bluebeam Q computer, 
it has been configured to allow connections to port 
4041 

o Open a Windows command prompt and attempt to do 
a network ping of the Q workstation. 
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• Try to print from the print client.  
o On the print client workstation, when you print from 

an application, you should see a “Save As” dialog 
prompting for the name to give to the PDF and the 
location to store the file.  
 

 
 

o If the “Save As” dialog does not appear, verify that 
“BBNetPrint” is running in the Task Manager. If it is 
not, explore the following path. 

 
C:\Program Files\Bluebeam Software\Client  
 

Once there, double
click on the BBNetPrint.exe file. 
 
This process should normally start on its own each time you reboot 
the workstation. The Registry key HKEY_LOCAL_MACHINE\ 
SOFTWARE\Microsoft\Windows\CurrentVersion\Run, should have an 
entry, BBClientStart, which should point to the EXE: 
 
 C:\Program Files\Bluebeam Software\Client\BBNetPrint.exe 
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Section 10.0 � Under the Hood: Q Architecture 
 
Q is built upon a component architecture. The two components which 
are of interest to the Administrator are the Converter and Listener.  
 
The Listener component shepherds the conversion process through 
the 4 other components of Q. This process manifests itself through 
the Windows Handler application. For example, the Listener monitors 
conversion jobs. If a conversion process is waiting for user input (i.e., 
an AutoCAD file is opened and a user prompt is displayed asking 
whether or not the drawing should be regenerated), the Window 
Handler automates the process of clicking the OK button to continue 
to the process of conversion. 
 
The Converter component is where the file type is tied to the 
mechanism for performing the conversion. There are four paths for 
converting from an input or source file into an output file. This concept 
is demonstrated in the diagram below:  
 

 
 
The source input file type determines what converter will get called for 
performing the transformation. Each converter has different 
capabilities for performing conversions. 
 
Plugin: This is the most powerful conversion path. Q leverages 
plugins to various host applications and because of this, can interface 
with the host application at a lower level than is typical. Bluebeam Q 
currently directly integrates with AutoCAD, SolidWorks, MS Word, 
PowerPoint and Excel. Any file types which can be natively handled 
by these applications can be converted through this mechanism. 
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What this means is that when Q encounters a DWG, SLDDRW, DOC, 
XLS, or PPT file, Q can call the appropriate plugin to process the 
conversion. Via the plugin, Q can set parameters such as whether or 
not to transfer file properties, bookmarks and hyperlinks, set pen 
tables and page sizes to use within AutoCAD and specify named 
layout sheets to convert. The linking of associating files types to 
specific plugins are set in the basicconfig.xml.  
 
Mime: There is a MIME printing path for those applications which Q 
does not directly integrate with. Using this path, Q issues the 
equivalent of a File > Print command to the application. An example 
of this would be a Microsoft Visio file. Q can be instructed to take any 
VSD file and, so long as the Visio application is installed on the Q 
server, will launch Visio, open the document and issue a print 
command to save the file in the specified output format. There are no 
mechanisms for controlling the page setup in applications using the 
MIME printing path; that is, the page setup (page size, scaling factor, 
etc.) in the mode which the files were last saved will be used when 
converted using the MIME conversion path. 
 
Postscript: Any encountered postscript (.ps) file can be handled 
natively by Q. A postscript file will be converted to the specified output 
format. 
 
Graphics: A set of standard raster based graphics formats can also 
be handled natively by Q. TIF, BMP, JPG, PNG, GIF are valid 
formats. 
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Section 11.0 � Script Engine & Conversion API 
 
Q provides a powerful set of automation functionality, enabling both 
the conversion of source documents (AutoCAD, SolidWorks) to PDF 
as well as the processing of PDFs in order to combine, flatten, stamp 
and perform up to 50 other functions. There are 2 sets of API function 
calls: one focused on the source file to output file creation (e.g., 
AutoCAD to PDF, Word to PDF); and the other available through the 
Script Engine interface for automating the processing of PDFs. The 
following figure depicts the API at a high level.  
 

          
 
 
The Bluebeam Q distribution includes many examples of using the 
API in the {Q Install folder}\Bluebeam Software\Conversion 
Server\Code Samples directory. A readme.txt file describes the 
sample projects included with the distribution. 
 
The Script Engine 
 
With Q, performing automated operations on your existing PDF files is 
now possible. The possibilities include applying Headers & Footers, 
Stamps, PDF Security and much more. Scripting is the mechanism 
that enables this functionality. Within Q there are several ways to 
utilize scripting. The following diagram depicts the interfaces to the 
Scripting Engine. 
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The easiest way to use scripting is with the Watched Folders (shown 
in green in the above diagram). Using the Bluebeam Q Manager, a 
batch script can be written that is executed on any file that is dragged 
into the specified folder. The Script Editor within the Bluebeam Q 
Manager has auto
complete and integrated help to make authoring 
scripts as simple as possible. Additionally, the scripting can be run in 
conjunction with the conversions that the Watched Folders already 
support. For instance, a watched folder can be set up to convert 
AutoCAD files to PDF, and then a script could run that adds PDF 
Security to the newly converted PDF file. The Watched Folders 
support a subset of the scripting commands that work in a batch 
environment.   
  
For users with .NET programming capabilities, all of the script 
commands are included in the Bluebeam Q API. This is represented 
in the preceding diagram by the blue area. Using the API makes more 
commands available, and, in contrast to the basic batching done with 
watched folders, logic can be applied to the operations done to the 
PDF. For instance, with the API, file properties could be queried from 
the PDF, and based upon the file properties present in the PDF, 
particular stamps could be applied. 
 
Finally, for users who do not use .NET, but still want full access to the 
scripting capabilities, scripts can be run directly from the command 
line. This is shown in the red “User Application” area of the diagram 
on the prior page. The script engine supports two modes: normal and 
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interactive. The normal mode simply runs the script and then exits. 
The interactive mode listens to the standard input for commands, and 
then writes the results back to the standard output. Using the 
interactive mode allows for the same capabilities as the API, but 
supports any language that can read and write to standard in and 
standard out. Also, a standalone version of the Script Editor is 
included with Q to help users write and debug stand
alone scripts. 
The Script Editor resides in {Q Install folder}\Bluebeam 
Software\Script folder. A help file describing the use of the Script 
Editor is located in: {Q Install folder}\Bluebeam 
Software\Help\ScriptEditorHelp.chm. 
  

The Q Conversion API 
 
This section gives a brief overview of the Q API. The complete API 
help is part of the Q installation and is located in the following default 
folder on the installed system: 
 
C:\Program Files\Bluebeam Software\Help\Bluebeam Q API Help.chm 

 
Q is built on the Microsoft .NET framework v3.5,sp1, however the API 
supports .NET 2.0 and later. It is recommended that Visual Studio 
2005, 2008 or 2010 be used for development. Bluebeam has supplied 
code samples for both C# and VB.NET. Getting started with either 
environment is very similar. One important point to note is that using 
the API will connect to an existing instance of the server. To use any 
of the examples, be sure that the server is already running.  
 
Creating a new Project and adding Reference paths 
Any Project type should work with Q, however for the purpose of this 
guide, create a Console Application. To do this open Visual Studio 
and click File > New Project, then select Console Application from 
either Visual Basic Projects or from C# Projects. The Q API is located 
in the file BBServerAPI.dll which is installed into C:\Program 
Files\Bluebeam Software\Conversion Server. After creating the new 
project, add a reference to BBServerAPI.dll, then Add the appropriate 
include statement as follows:  
 
Visual Basic 
Imports Bluebeam.Hydra.LightProgrammaticInterface 

 
C# 
using Bluebeam.Hydra.LightProgrammaticInterface; 

  
Simple Example 
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The following code example should be entered into the Main() 
function. It illustrates the most basic usage of Q. Refer to the included 
sample projects under C:\Program Files\Bluebeam 
Software\Conversion Server\Sample Code.  
 
Visual Basic 
Dim task As ITask = TaskManager.CreateNewTask() 
Dim inputFile As IInputFile = 
task.InputFiles.Add("c:\Test\colorwh.dwg") 
task.OutputFullPath = "c:\Test\colorwh.pdf" 
task.Run() 

 
C# 
ITask task = TaskManager.CreateNewTask(); 
IInputFile inputFile = 
task.InputFiles.Add(@"C:\Test\colorwh.dwg"); 
task.OutputFullPath = @"C:\Test\colorwh.pdf"; 
task.Run(); 
 

A slightly more complicated VB.NET example is shown next.  
 
Imports Bluebeam.Hydra.LightProgrammaticInterface 
 
Module AdaptorExVB 
Sub Main() 
Dim task As ITask = TaskManager.CreateNewTask() 
Dim inputFile As IInputFile = 
task.InputFiles.Add("c:\Test\colorwh.dwg") 
task.OutputFullPath = "c:\Test\colorwh.pdf" 
 
Dim controller As ITaskController = task.Controller 
While controller.MoveNext() 
  If controller.CurrentConverterName = "AutoCAD.plugin" Then 
    Dim conv As ITaskConverter = controller.CurrentConverter 
    conv.Adapter.PageSizeEnum = PageSizeEnum.ANSI_D 
    conv.Adapter.ScaleType = BbScaleType.ScaleToFit 
 
    conv.Convert() 
   End If 
 End While 
End Sub 
End Module 
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The following illustration depicts another annotated example. Please 
refer to the API samples and help on the Q server for further details.  
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Section 12.0 � Troubleshooting Q 
 
This section provides further background information regarding initial 
setup and troubleshooting of Q.  
 
Q has several prerequisites; please verify that you have performed 
these actions before/during the install: 
 
Validating the Q Installation 
1. Q leverages the Bluebeam plugin integrations to AutoCAD, 
SolidWorks and MS Office (Word, Excel & PowerPoint). In order to 
make the installation run as smoothly as possible, it is recommended 
that you install these applications before installing Q. If you will be 
converting AutoCAD drawings, make sure AutoCAD is installed. If you 
are converting MS Office drawings, make sure that you have installed 
MS Office apps. 
 
2. If intending to run in service mode, identify the account which you 
want to run the Q processes as. At install time you will be prompted 
for username and password for this account. This account should 
have local administrator privileges and the following permissions 
should be allowed: 
   

• log on as a service 

• adjust memory quotas for a process 

• replace a process level token 
 
Note: As part of the installation process, these above permissions will 
be automatically set on the user account. 
 
3. You should log in as the user defined in Step 2 and start Word, 
Office, Excel and AutoCAD and verify that the applications start up 
and are initialized. 
 
4. Log in and perform the Q Install as local System Administrator, or 
local user with Administrative privileges. 
 
5. Once you have installed the Q software, you should log in as the 
account identified in Step 2 and start AutoCAD and the Office 
applications to verify that the integration with these applications has 
completed successfully. The easiest way to tell if the integration has 
happened is if you see the Bluebeam PDF creation buttons in the 
source applications (AutoCAD, SolidWorks and MS Office). You 
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should also click the Create PDF button in the application to ensure 
that the PDF is created successfully through the plugin interface. 
 
6. To make sure that the desired services start on login, reboot the 
workstation. 
 
 
Files dragged into Watched Folder not converting 
Q maintains a database of converted jobs. If a file is dragged to a 
particular watched folder it will convert once. The second time the 
same file is dragged to the watched folder, it will not reconvert 
because there is logic in the server to only convert a particular file 
one time. In order to make the file convert again, the file will have to 
be modified. Modifying the source file will trigger the server to convert 
the file again. 
 
Alternatively you can force Q to re
convert an un
modified source file 
regardless of whether or not it has been converted before. In the Q 
Manager, check the do not reconvert files which have not been 
updated checkbox in the Watched Folders > Filter tab.  
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Section 13.0 �   Technical Support 
 
If you require further assistance, please contact your authorized 
Bluebeam reseller, or contact Bluebeam directly by one of the 
methods below. Technical support is available through our website or 
e
mail at: 
 
www.bluebeam.com 
support@bluebeam.com 
 
 
Other Contact Information  
 
Bluebeam Software, Inc. 
766 E. Colorado Blvd. 
Suite 200 
Pasadena, CA 91101 
Main: 626.296.2140 
Fax: 626.398.9210 
www.bluebeam.com 
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